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Introduction

Thank you for purchasing our product.

The Skin Analysis Software CM-SA2 is designed to take skin measurements with instruments such as the CM-17d 

connected to your computer to obtain Melanin Index, Hemoglobin Index (Hb Index), Blood Oxygen Saturation 

Index (Hb SO2 Index), and Individual Typology Angle (ITA°).

This instruction manual describes the operating environment, installation procedures, and operation methods 

required to use the software.

Notes on Safety
Be sure to read this instruction manual as well as the instruction manuals for the instru-

ments and your computer carefully before use to ensure proper and safe operation.

A PDF version of this instruction manual will also be installed at the same time the software is installed. To access 

the instruction manual while using the software, select [Help] – [Manual] from the software menu. A PDF reader is 

required to view the PDF file.

 ■ Precautions When Taking Measurements
1. Light leaks if there is any opening between the measurement target and the measurement unit, and this 

tends to result in a lower melanin value being measured.

 To prevent measurement errors, ensure that the measurement unit is in close contact with the 

measurement target during measurement.

2. Be careful not to press the measurement unit too forcefully against the measurement target, as this may 

cause congestion.

3. Measurements cannot be taken if the measurement target contains dermal lesions (i.e., blue nevus, such 

as nevus of Ota).

4. Do not emit light from the measurement unit while it is pointed at a person’s eyes. Also, do not take 

measurements by placing the aperture on the sample-facing surface of the measurement unit directly 

against the eyelid, even when the eyes are closed.

 ■ Warnings Regarding This Manual
  Unauthorized reproduction or duplication of the contents of this manual, in whole or in part, is prohibited.

  The contents of this manual are subject to future change without notice.

  The contents of this manual have been prepared with the utmost care. However, should you have any questions 

or comments, or if you notice any errors, omissions, or other such issues, please contact the nearest KONICA 

MINOLTA authorized service facility.

  KONICA MINOLTA bears no liability whatsoever for any accidents or damages resulting from use of this product 

in a manner that is not in accordance with the instructions in this manual.

  The screen images shown in this manual are for illustrative purposes only and may differ from the actual 

product screens.
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 ■ Terms of Use for This Software
The terms of use for this software are provided in the License Agreement displayed on-screen during the 

installation process. The license agreement of this software includes prohibitions during use. This software can be 

downloaded only if you agree to all the terms of the license agreement.

 ■ Notes on Use
  Please do not use this software to assist in cosmetics sales at retail stores.

  This software and the spectrophotometer that can be connected to this software are not medical devices. The 

results output by this software cannot be used for diagnosis, treatment, or any other medical purposes.

  The CM-SA2 application software is designed to be used with the Windows 10 or Windows 11 operating 

system. Note that neither operating system is included with this software.

  One of these operating systems must be installed on your computer before this software can be installed.

 

Notes  For details on the environment required to use the software, refer to P.5.

 ■ Official Names of Software Used in This Manual
(Name Used In-Text) (Official Name)

Windows, Windows 10 Microsoft® Windows® 10 Pro Operating System

Windows, Windows 11 Microsoft® Windows® 11 Pro Operating System

 ■ About Trademarks
  Microsoft, Windows, Windows 10, and Windows 11 are registered trademarks of Microsoft Corporation in the 

United States and other countries.

  Intel Core i5 is a registered trademark of Intel Corporation in the United States and other countries.

  All other company names and product names that appear in this manual are registered trademarks or 

trademarks of their respective owners.

Every effort has been made to ensure that this product works properly. However, should you have any questions or 

comments, please contact the nearest KONICA MINOLTA authorized service facility.
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	■ Use Conditions
OS Windows 10 Pro 64-bit Ver. 1903 or later

 Windows 11 Pro

  Japanese, English, Simplified Chinese, Traditional Chinese, and Korean versions of the above OS.

  The computer system configuration must either be the configuration recommended by the above OS 

or the specifications listed in the table below, whichever is higher. 

Item Requirement

CPU Intel Core i5 2.7 GHz equivalent or higher (recommended)

Memory At least 2 GB (at least 4 GB is recommended)

Storage At least 10 GB of free space

Monitor resolution Display capable of a resolution of 1,280 × 768 (WXGA) or higher 

and 16-bit color or higher (recommended)

Connection to external networks Required when obtaining (downloading) this software and 

 when performing license activation procedures

USB port Required when connecting the instrument and your computer 

with a USB cable

 ■ List of Compatible Instruments
This software is compatible with the following instruments.

Instrument Firmware Version

Spectrophotometer CM-17d / CM-16d All firmware versions

Spectrophotometer CM-700d / CM-600d 1.23.0005 or later

Spectrophotometer CM-2600d / CM-2500d 1.42.0000 or later

*  You can check the firmware version of the instrument on the instrument display. 

For how to check the firmware version, refer to the instruction manual for the instrument.

*  If the firmware of the instrument to be connected is older than the above version, an error message is displayed and you will not 

be able to connect the instrument. For firmware updates, please contact your nearest KONICA MINOLTA service center.

 ■ Display Languages
Japanese, English, Simplified Chinese, Traditional Chinese, and Korean

  Can be selected during installation (Refer to P. 6) and changed after installation (Refer to P. 53)

Operating Environment
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 ■ Downloading Skin Analysis Software CM-SA2
1.  Download this software from the KONICA MINOLTA website (located at the URL below).

https://www.konicaminolta.com/instruments/download/software/color/cmsa2/index.html

To download the software, follow the instructions on the KONICA MINOLTA website.

Memo  To download the software, the following is required. 

 • Read the End User License Agreement and click the “I Agree” button.

 • Enter your Personal Information in English and click the “Submit” button.

 • Check the information you entered and click the “Send” button.

 • You will receive an email from GlobalCoreSite Administrator <sensing-gc@konicaminolta.com>. Open this email and 

download the software from the URL provided in the email.

2.  Extract the compressed file you have downloaded to a folder on your computer.

  The setup file is included in a *.zip compressed file.

 ■ Installation Procedure
Install Skin Analysis Software CM-SA2.

  To install this software, log on to Windows with a user account that has administrator privileges.

  If the instrument is connected to your computer, disconnect it.

  During the installation of the software or each driver, the screen for confirming User Account Control will be 

displayed several times. When this happens, select [Yes].

Procedure

1. Start Windows.

  If Windows Update is running, wait until it is finished, restart your computer, and then install Skin Analysis 

Software CM-SA2.

2. Check the setup file.

  Confirm the destination folder for the unzipped files.

  The file name is [setup.exe].

3. Double-click the setup file.

  The installation program will start.

  It may take several minutes for the setup screen to appear.

Installing the Software

https://www.konicaminolta.com/instruments/download/software/color/cmsa2/index.html
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4. The Installer Language Selection screen is displayed.

From this window you can select the language to use during installation.

  Select the language you want to use from the drop-down list.

 

5. Click the [OK] button.

  Depending on your computer environment and other software installed, the Skin Analysis Software CM-SA2 

installer may determine that Microsoft components (such as .NET 4.5.2 Framework) also need to be installed. 

In that case, installation of those components will begin.

  You must agree to the license agreement(s) for the component(s) to be installed.

  You may need to restart your computer. In that case, restart your computer and follow the above steps from 

Step 1.

6. Click [Next].
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7. Read the Product License Agreement and, if you agree,

select [I accept the terms in the license agreement], and then click [Next].

8. The installation program will confirm the installation folder.

To install the software in that folder, click [Next].

  To install in a location other than that folder, click the [Change...] button, select or enter a new path, and then 

click [Next].
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9. Click [Install].

  Do not perform any other tasks on your computer until the installation is completed.

  A dialog box for driver installation may be displayed during installation. Be sure to install the driver. If driver 

installation is canceled, CM-SA2 installation will also be canceled. 

10. Installation is completed. Click [Finish].

  When installation is completed, a shortcut icon for [Skin Analysis Software CM-SA2] will be displayed on your 

computer’s desktop.

  A shortcut to CM-SA2 will also be added to the Windows Start menu as [KONICA MINOLTA] - [Skin Analysis 

Software CM-SA2].
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 ■ Uninstalling the Software
CM-SA2 can be uninstalled using the standard Windows uninstallation method.

1. Right-click the Start button located at the bottom of the screen. 

From the menu, click “Apps & features” if you are using Windows 10, or “Installed apps” if you are using Windows 11.

2. Select [Skin Analysis Software CM-SA2] from the list, then click [Uninstall].

3. A confirmation dialog box for uninstalling the application will appear. Click [Yes].

4. A dialog box for checking software updates will appear. Follow the instructions on the screen to 

complete the uninstallation.

 Notes  Microsoft components that were installed during the installation of CM-SA2 will not be uninstalled when CM-SA2 

is uninstalled. Do not uninstall these Microsoft components, as they may be used by other software.
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License Activation

 ■ Activating the License
If you have purchased Skin Analysis Software CM-SA2, you must activate your license online.

Be sure to follow the steps below to activate your license.

Notes  The following is required to activate your license.

  • Product key.

*  KONICA MINOLTA Sales or the distributor from whom you purchased the software will send you the product 

key by email or other means at the time of purchase.

• CM-SA2 must be already installed on the computer using this software.

• The computer using this software must be connected to the Internet.

<Pre-Configuration>

Once user registration (Steps 6 to 9 below) is completed, an email will be automatically sent from our system to 

the registered email address.

　　Subject: [Konica Minolta] Notification of Completion of User Information Registration

　　Sender Email Address: webmaster@selms-mail.konicaminolta.com
Be sure to configure your email settings before registering so that you can receive emails from webmaster@

selms-mail.konicaminolta.com.

* If you are unsure how to configure email settings, ask your company’s IT department.

Memo  • License activation is a procedure that is required to add license information to the product you have purchased and 

enable it to function as a legitimate, authorized product. The Skin Analysis Software CM-SA2 license grants you the right 

to install and use the software on one specific computer.

 • You can use this software without activating a license during the free trial period (30 days from initial installation).

 • However, if the free trial period expires without the license being activated, you will no longer be able to start this 

software unless you activate the license.

Procedure

1. Click the [Activate] button on the screen below that appears when the software starts up.

  To start the software, double-click the [Skin Analysis Software CM-SA2] shortcut icon on your desktop.

 

X
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Memo  If it has been fewer than 30 days since you first installed CM-SA2, you can also start the license activation procedure using 

methods i to iii below. 

i.  Start the software.

• Double-click the [Skin Analysis Software CM-SA2] shortcut icon on your desktop.

ii.  Click [Help] menu → [Version and License Info]. 

iii. Click the [Activate] button on the Version and License Info screen.

* If the free trial period has ended and the software does not start, begin with method Procedure  1.

2. The Product Key Input screen is displayed.

Enter the product key, then click [Next].

 

3. The screen below is displayed. Click the URL provided on the screen.
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4.  The following screen will be displayed in your web browser.

 

5.  Confirm the registered license.

  The product name of the product for which you are registering (activating) the license is displayed in the 

Product Name field. Confirm that “Skin Analysis Software” is displayed in the Product Name field, and then 

check [This matches to the items of the order.].
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6. Perform user registration.

  The items in the green boxes below are required fields. Entries in other fields are optional.

 

Memo  • If you have registered as a user when purchasing SpectraMagic NX2, SpectraMagic DX, or related products in the past, 

you will need to register as a user again. This is necessary in order to link the product key and user information.

 • You can check your license information and confirm or change your registered user information using the email address 

and password you set during user registration.

  Click [I agree about the handing of personal information.].

After reviewing the contents of [Handling of Personal Information (Privacy Notice)], check () the box ( □ ) 

on the left.

In order to complete the license activation procedure and use this software, you must first agree to the 

handling of your personal information.

  Once you have finished entering the information, click [Confirmation and registration].
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7. The User Information Confirmation screen is displayed. Confirm the information you have entered.

 

  To correct the information you have entered, click [Back] to return to the input screen and re-enter the 

information.

8.  If you are registering as a user for the first time, the screen for setting your password will be dis-

played at the bottom of the screen.

Set your password and click [Registration].

  The password must be at least 10 characters long and include at least one uppercase letter, one lowercase 

letter, one number, and one special symbol (_$@%#&<>*+~:|-+).

 

If you have registered as a user in the past, a screen for entering your password will be displayed at the bottom 

of the screen.

Enter the password you set previously and click [Registration].

 

If you forgot your password, click [Forgot Password] and follow the instructions on the screen.

Reset your password, enter the new password, and click [Registration].
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9. Confirm that user registration has been completed.

Once user registration is completed, 

(1) [The user registration has been completed.] is displayed on the upper part of the screen.

You must close your web browser before performing the following tasks.

(2) Our License Management System will send you an email to notify you that your user registration has 

been completed.

Sender Email Address: webmaster@selms-mail.konicaminolta.com

Confirm that you have received this email.

10.  Click [Next] on the screen below.
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11.  Activate the license and install the software.

Confirm that Skin Analysis Software is displayed on the screen below, click [Next], activate the license, and 

install the software.

12.  Confirm that the license installation is completed.

The screen below will be displayed when the license installation is completed.

A message indicating that the license has been activated and which product has been activated is displayed.

Confirm the details provided on the screen and click [Finish].
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Notes

Important License Precautions
The license for Skin Analysis Software CM-SA2 is linked to the computer on which the license is installed and 

activated. If you move this software to another computer (e.g., when you replace your computer with a new 

one), migrate the license to your new computer before uninstalling the software from your old computer.　　

 ■ Migrating the License
You can migrate your CM-SA2 license from your old computer to a new one when necessary, such as when you buy 

a new computer.

Notes  • To migrate your license, log on to Windows with a user account that has administrator privileges.

 • Licenses are migrated over the network. Both the source and destination computers must be on the same 

network.

 • Confirm the IP address or computer name of the destination computer before migrating your license.

Procedure

Source Computer Destination Computer

1 Install CM-SA2 on the destination computer (the 

computer to which you want to migrate the license).

2 Start CM-SA2 on the destination computer.

• If CM-SA2 does not start, launch the license migration 

tool directly from Explorer. The license migration tool is 

located in the folder below.

C:\Program Files\KONICA MINOLTA\CM-SA2\

CMSALicenseTransferTool.exe

If the [User Account Control] dialog box appears and asks 

whether you want to run the license migration tool, click 

[Yes].

Proceed to Step 5 below.

3 Select [Version and License Info].
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Source Computer Destination Computer

4 The Version and License Info screen is displayed.

Click the [Transfer] button.

 The [License management] dialog box is displayed.

• If the [User Account Control] dialog box appears and 

asks whether you want to run the license migration tool, 

enter your username and password, and then click [Yes].

5 Select [Receive and install license on this computer] and 

click [Next >].

6 The [License transfer] dialog box is displayed, showing 

the IP address of the destination computer.

7 Start CM-SA2 on the source computer.
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Source Computer Destination Computer

8 Select [Help] menu → [Version and License Info].

The Version and License Info screen is displayed.

9 Click [Transfer].

The [License management] dialog box is displayed.

• If the [User Account Control] dialog box appears and 

asks whether you want to run the license migration tool, 

enter the username and password of the administrator, 

and click [Yes].

10 Select [Transfer license from this computer] and click 

[Next >].

11 The [License transfer] dialog box is displayed.

(1) Click on the current license and select the license 

to migrate from the drop-down list that appears. The 

information for the selected license is displayed. 

(2) Click the drop-down button and select the destination 

computer from the list that appears.

If you cannot find the destination computer in the list, 

enter the IP address of the destination computer in the 

[Manual] text box.

•  When entering the IP address manually, omit the 

[http://] string at the beginning and the port 

number [:xxxx] at the end, and enter only xxx.xxx.

xxx.xxx (the part enclosed by the red dotted line in 

the image in Step 6). For example, if the dialog box 

displays [http://100.111.123.145:2000], enter only 

[100.111.123.145].

(1)

(2)
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Source Computer Destination Computer

12 Click [Transfer]. Your computer will contact the license 

server and begin transferring your license to the license 

server.

The progress status is displayed in the dialog box.

The progress status is displayed in the dialog box.

13 When the transfer of your license to the license server is 

completed, click [Finish] to close the dialog box.

When the transfer of your license to the license server is 

completed, click [Finish] to close the dialog box.
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 ■ Major Functions
Skin data display Melanin Index

Hb Index [Hemoglobin (oxidized and reduced) index]

Hb SO2 Index (%) [Hemoglobin oxygen saturation index (%)]

ITA° [Individual Typology Angle]*1

ITA° classification

Colorimetric 

value display

L*, a*, b*, C*, h, Munsell value (Hue, Value, Chroma)*2

Graph Display Hue - Value Graph

Hb Index - Melanin Index Graph

ITA° Graph

Dual-Axis Graph*3

Data output*4 Saving/reading data in CM-SA2 original format

Saving data in CSV format

[Melanin Index, Hb Index, Hb SO2 Index (%), L*, a*, b*, C*, h, ITA°, ITA° classification, 

Observer/Illuminant, measurement area, instrument name

Munsell value (Hue, Value, Chroma), Spectral reflectance (400-700 nm)*5]

Other Saving and displaying measured viewfinder image (CM-17d)*6

*1: The ITA° is calculated under environmental conditions of 2° observer and illuminant D65.

*2: The Munsell value is calculated under environmental conditions of 2° observer and illuminant C.

*3: The colorimetric values for each axis can be selected from L*, a*, b*, C*, and h.

*4: Data used in applications such as Excel should be saved in CSV format. The CM-SA2 software cannot reload data saved in 

CSV format. For that purpose, you need to save the data in the original CM-SA2 format.

*5: The spectral reflectance to be output is the reflectance obtained in SCI (specular component included) mode.

*6: Data will be saved only when the CM-17d is connected, the viewfinder image is displayed, and the save settings of this 

software have been configured prior to measurement. Images captured during measurement are saved in a format linked to 

the measurement data and can be displayed later.

Memo  

□ About ITA°

Abbreviation for Individual Typology Angle, one of the indicators used to classify skin color.

An angle calculated in the CIE-L*a*b* color space that expresses color intensity.

The ITA° classification for each data point is displayed as one of the six categories in the table below.

Overview

ITA° ITA° classification

ITA° ≳ 55 Very Light

41 ≲ ITA° ≤ 55 Light

28 ≲ ITA° ≤ 41 Intermediate

10 ≲ ITA° ≤ 28 Tan

-30 ≲ ITA° ≤ 10 Brown

ITA° ≲ -30 Dark
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 ■ Screen Configuration
The main screen of Skin Analysis Software CM-SA2 is configured as shown below.

No. Screen Configuration Part Description

① Menu bar, toolbar Bar for selecting the function to execute

② Auto Save Settings button Switch button for function to overwrite and save data each time 

measurements are taken.

③ Group list Group search and display

④ Data list Displays data linked to the selected group.

⑤ Graph/Measurement image area Displays the selected graph or measurement image.

* The measurement image can only be displayed when the 

viewfinder image is saved during measurement using the CM-17d.

⑥ Status bar Displays the name of the instrument connected to the software, the 

serial number (not displayed if not connected), the currently set 

observer/illuminant, the measurement area, and the threshold 

warning settings.

1

3

5

6

2

4
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 ■ Basic Flow of Operation

Connect the measuring instrument and your computer

Start the software

Set measurement conditions (measurement area, illuminant/observer)

* As necessary.

* As necessary.

Calibrating the Instrument (Zero Calibration, White Calibration)

Measurement

Exit the software

• Set the default data name and comment

• Add groups

• Set the illuminant/observer

• Edit the data name and comment

• Configure screen display settings (data list, graph, images 

taken during measurement)

• Save the file

• Output the data (save in CSV format)

• Print or output the PDF
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 ■ Connecting the Measuring Instrument and Your Computer
For instructions on how to connect the measurement instrument to your computer, refer to the instruction manual 

for the measuring instrument.

 Memo  You can connect via a USB cable or, for some instruments, wirelessly using a wireless LAN, Bluetooth module, or other 

accessory (sold separately).

Notes  • Connecting the instrument to your computer for the first time may require the installation of a device driver.

 • When using the CM-17d, you can display the electronic viewfinder image captured by the CM-17d’s built-in 

camera during measurement on the screen for this software and save it together with the measurement data.

  However, be sure to connect the CM-17d to your computer via a USB cable or wireless LAN when using the 

above functions. These functions are not available when using a Bluetooth connection. (Not compatible.)

 • If you are using CM-2600d or CM-2500d, use the driver that comes with the USB serial conversion cable.

 ■ Confirming the Port No.
Confirm the COM port on your computer to which the instrument has been assigned.

Procedure

1.  Right-click the Windows Start button located at the bottom of the screen.

2.  Click [Device Manager] in the menu that appears to open [Device Manager].

• Log on to Windows with a user account that has administrator privileges.

3.  Double-click [Ports (COM & LPT)].

•  The group is expanded and the COM port number assigned to the instrument is displayed. Confirm the port 

number.

Notes  This COM port number may be required when you start CM-SA2 and connect to the instrument.

 

Memo  • If the connected instrument is not displayed in [Ports (COM & LPT)] and instead [Unknown device] is displayed, right-

click [Unknown device], select [Update driver], and select the corresponding subfolder under the folder where Skin 

Analysis Software CM-SA2 is installed.

CM-17d and CM-16d:  KMMIUSB

CM-700d and CM-600d:  kmsecm700

 • If the Windows security dialog box appears, click [Install].

 • Confirm the COM port on your computer to which the instrument has been assigned.

Basic Operation
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 ■ Starting the Software
Double-click the [Skin Analysis Software CM-SA2] shortcut icon on your desktop.

 Memo  • You can also start the software by selecting the [KONICA MINOLTA] - [Skin Analysis Software CM-SA2] icon in the 

Windows Start menu (or Start screen).

 • To exit the software, click [Exit] in the [File] menu.

	□ Connecting the Instrument and Software

Select [Connect] from the [Instrument] menu or click the Connect button to connect.

When the instrument and your computer are connected properly and the software is connected to the instrument, 

the model name and serial number of the connected instrument are displayed on the lower left of the screen.

<Display Example>

 

Connect button
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 □ Setting the Serial Port (COM Port)

When the software is started, the following may appear depending on the number of instruments connected to your 

computer, the instrument model, or the connection status, in which case you will need to select a port number.

Example of Instrument communication settings screen

 

Select the COM port number of the instrument to use from the drop-down list.
* For information on how to confirm the COM port number, refer to P.25.

Notes  • When some connection failure such as the measuring button on the instrument becoming disabled occurs 

during the use of this software, select [Connect] from the [Instrument] menu for reconnection. If the problem 

is not resolved, refer to [Connecting to an External Device - Connecting a Personal Computer (or Other 

Computer)] and [Troubleshooting] in the instruction manual for the instrument.

 ■ Setting the Measurement Area (CM-17d, CM-700d, and CM-2600d Only)
You can select either MAV or SAV as the measurement area (a measurement condition) as appropriate for the size 
of the target area and other factors.
On the instrument side, set the switch on the instrument body and attach a target mask that is appropriate for 
the selected measurement area. For information on how to do these things and related precautions, refer to the 
instruction manual for the instrument.

Be sure to also set the measurement area in the software to the selected measurement area before performing 
calibration or measurement.

Procedure

1.  Click [Instrument] menu → [Measurement condition settings].　	
The Measurement Condition Setting screen is displayed.

2.  Select the appropriate measurement area (MAV or SAV) and click the [OK] button.

 Memo  • The measurement area set in the software is displayed in the status bar located on the lower part of the screen. (MAV or SAV.)

 • A warning message is displayed if the settings for the instrument and the software do not match.
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 ■ Calibrating the Instrument (Zero Calibration, White Calibration)
The calibration screen appears automatically when the software is started. You can also perform calibration by 

selecting [Calibration] from the [Instrument] menu. Follow the instructions displayed on the screen to perform the 

calibration correctly.

- Zero Calibration Screen Example - - White Calibration Screen Example -

　

Notes  • For calibration precautions, refer to the instruction manual for the instrument.

 • When using the CM-17d, CM-700d, or CM-2600d, set the measurement area before performing calibration. 

Perform calibration with the appropriate target mask attached.

 • If you need to change the measurement area during measurement, set the correct measurement area in the 

software, perform calibration, and then resume measurement.

 ■ Taking Measurements
Press the measuring button on the instrument to start measurement.

  The measured data is stored in the selected group.

  One group can store a maximum of 100 data measurements.

  Note that a maximum of 10,000 data measurements can be stored in a single file.

 Notes  •  Before starting measurement, be sure to check the connection between the instrument and the software. 

(Refer to P.26)

 • When using CM-17d, CM-700d, or CM-2600d, the measurement area settings should also be confirmed.

 • When measuring with the CM-17d, press the measuring button and release your finger immediately.

  Press and hold the button (for at least 0.5 seconds) to cancel the measurement and bring up the measurement 

position confirmation screen.
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 ■ Setting Data Items Displayed Onscreen
You can set whether to display or hide items No. 2 to 5 and No. 12 to 18 in the table below in the data list on the 

screen.

<Table>

No. Item Display

1 Data name Normal display

2 Comment Show/hide can be set

(default = show)3 Melanin Index

4 Hb Index

5 Hb SO2 Index (%)

6 Hue Normal display

7 Value

8 Chroma

9 L*

10 a*

11 b*

12 C* Show/hide can be set

(default = hide)13 h

14 ITA°

15 ITA° classification

16 Observer/Illuminant

17 Measurement area

18 Instrument name

Procedure

1.  Select [View] menu → [List Item Settings].

2. The List View Item Settings dialog box is displayed.

 Select the items to display in the data list and click the [OK] button.

 Memo  • The order in which the items are displayed cannot be changed. (I.e., the order is fixed.)

 • Column widths can be adjusted for each item.

 • If the right side of the software screen is not visible due to your computer’s (i.e., Windows’) Scale and Layout settings, 

adjusting the display size may help.

Example of Procedure

1. Right-click anywhere on the desktop where there is an empty space on the screen.

2. Select Display Settings.

3. Adjust the zoom in/out.

Example: If zoom in/out is set to a value like 150% or 125%, change it to 100%.

Data
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 ■ Setting the Initial Data Name and Comment
You can configure the initial data name and comment settings prior to performing measurement.

Procedure

1. Select [Measurement data settings] from the [Data] menu.

2. Configure the data name and comment settings in the [Data Name Setting] tab.

The data you measure will be given data names in the format you have set in the [Data Name Setting] tab.

  Data names can be up to 64 characters long.

The comments set on the above screen will be applied to all data.

  Comments can be up to 64 characters long.

 Memo  • If you do not set any default data and measure without making any changes from the initial state, the measurement data 

will be named in the format “Data #00001,” “Data #00002,” “Data #00003,” and so on, with the number incrementing 

each time a measurement is taken. In addition, if the comment field is left blank, the date and time of measurement 

(yyyyMMddhhmmss) will be recorded automatically.
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 ■ Editing the Data Name and Comment
Follow the steps below to edit data names and comments after measurement.

Procedure

1. Select the data to edit on the software screen, and right-click while the background color is set to 

light blue.

2.  A menu is displayed. Select [Data Property].

 

3.  The [Data Property] screen is displayed, where you can edit data names and comments.

  Up to 64 characters can be used for the data name and comment.

4.  When you have finished editing, click the [OK] button.
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 ■ Deleting Data
To delete data, select the data to delete, and right-click to display the menu and select [Delete] while the 

background color is set to light blue.

 ■ Showing Data Properties
To show data properties, select the target data, and then right-click and choose [Data Properties] from the menu 

while the background color is set to light blue.

The following information about the data is displayed.

Data name, measurement date and time, instrument name, serial number, measurement area, specular 

component mode, and data comments
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 ■ Checking/Unchecking All Data
Check the box to the left of [Data Name] to select the average value and all data.

Uncheck the box to the left of [Data Name] to deselect the average value and all data.

 Notes  Data marked with a check mark （	✓▢	） will be displayed on the graph.

 Memo  • The first row of the data list is the average value of the checked data. The second row is the standard deviation of the 

checked data.

 • When there are two or more checked data items in the third row or lower of the data list, the values are calculated and 

displayed. (Only for items for which calculation is possible.)
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 ■ When Adding Averaged Data to the Data List
After taking several measurements, you can select any two or more data points recorded in the data list for the 

same group and add their average value as data to the final row of the data list.

Procedure

1.  Select the target data to be averaged from the data list on the screen.

• You must select at least two data items.

• To select multiple data items, hold down the Shift or Ctrl key and click the rows of the target data in the data 

list on the main screen. The background color of the selected data rows will change to light blue.

2.  Right-click on the selected row (background color: light blue).

3.  A menu is displayed. Select [Average Selected Data].

 Notes  The information indicating the data used as the basis for calculating the average value of the data you have 

added in the above procedure is not recorded automatically. If necessary, change the data names or comments 

so that the target data can be identified when viewed later.

 Memo  • The first row of the data list displays only one type of average value, and no further additions can be made to the data 

list.

However, if you generate average data rows using the above procedure, you can repeat the procedure to add multiple 

average data entries for different targets to the data list. This function is especially useful when you need to visually 

compare multiple averaged data items, such as when analyzing changes over time.

 • You can also plot the averaged data on a graph by checking the box to the left of the averaged data you have added to 

the data list.
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 ■ Setting the Observer/Illuminant
Set the observer and illuminant that serve as observation conditions for colorimetric values (L*, a*, b*).

You can change the display color values by changing the conditions (observer, illuminant) before starting 

measurement or even after measurement.

Procedure

1.  Select [Observer/Illuminant setting] from the [View] menu.

2.  The Observer/Illuminant dialog box is displayed.

 Select one of the four conditions below.

(1) 2° observer/illuminant D65 (Default)

(2) 10° observer/illuminant D65

(3) 2° observer/illuminant C

(4) 10° observer/illuminant C

3. Select the desired conditions, and then click the [OK] button.

Memo  •  The observation conditions (observer/illuminant) that are currently set are displayed in the status bar located on the 

lower left of the screen.
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This software allows data management by group.

 ■ When Adding a Group
 Select [Add Group] from the [Data] menu.

  Up to 100 groups can be created.

  Each group can store a maximum of 100 data items.

 ■ When Editing a Group Name
1. Right-click while the group to edit is selected, or select [Edit Group Name] from the [Data] menu.

2.  Enter the group name you want to use in the Group Name Edit screen and click the [OK] button.

  Group names can be up to 30 characters long.

  The first group name is set to “Group1” by default. Each time a group is added, a name is assigned in the 

format “Group2,” “Group3,” and so on, with the number incrementing with each group added.

Group
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 ■ When Deleting a Group
Select the group to delete from the groups displayed in the group list on the upper left of the screen.

With the group selected, right-click or choose [Delete Group] from the [Data] menu.

 Notes  • When a group is deleted, all the data linked to the deleted group is also deleted.

 

 ■ Group Search
You can enter conditions (such as letters, numbers, or symbols) in the search box to display only those groups that 

contain the conditions you entered in their group name.

Search Box

 

 Memo  • ×/100 will be displayed to the right of the search box. (This is the group counter.)

  × indicates the total number of groups that have been created.

  100 is the maximum number of groups that can be created.
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 ■ Graph Display
You can use this software to display the data you have measured as a graph. (By group units only.)

Table

No. Graph Type X-Axis Y-Axis

1 Hue-Value graph Hue Value (brightness)

2 Hb-Melanin graph Hb Index

(hemoglobin index)

Melanin Index

3 ITA° Graph b* L*

4 Dual-axis graph You can select which graph to display from

five patterns combining L*, a*, b*, C*, and h.

 ■ Graph/Measurement Image Area Settings
Graphs No. 1 and No. 2 in the table above are displayed in the graph/measurement image area by default.

<Initial State>

You can customize the graph/measurement image area and graph using the various buttons located in the upper 

right.

<Close-Up View>

Button Name Description

● Move to Center button You can change the display range of the graph so that the data 

you selected (background color: light blue) is positioned near 

the center of the graph.

* This function is only available for Hue-Value graphs and dual-

axis graphs.

Reset button Restores the graph to its default state after its display range has 

been changed.

Graphs
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Button Name Description

――/□□ buttons Click the [――] button to minimize (hide) the graph.

Click the [□□] button to maximize the graph.

↓↓ / ↑↑ buttons Click the [ ↑↑ ] button to enlarge the graph display area.

Click the [ ↓↓ ] button to shrink the graph display area.

Settings button Click this button to change the type of graph displayed on the 

screen or to configure items.

* The measured viewfinder image display settings with the CM-17d 

can also be adjusted with this button.

	■ Selecting the Graph to Display and Configuring Settings

Procedure

1.  Click the Settings button. Alternatively, select [View] menu → [Graph/Measurement image area 

settings].

2.  The screen below is displayed. Check the graph to display and configure settings as necessary.

3.  Click the [OK] button.
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 Memo  • The reliability ellipse is derived from a reliability ellipse that is based on cheek measurement data of Japanese women.

The degrees of reliability are 90%, 95%, and 99% from the center outwards (n=899). 

 Notes  • Auto Range Adjust is a function that automatically adjusts the graph range so that all data is displayed on the 

graph.

  In the dual-axis graph, the Auto Range Adjust function must be turned off for the [●Move to Center] and 

[Reset] buttons to function.

 ■ Selecting the Object Group and Data for Graph Display
Each graph displays data for the group that is selected in the group list on the screen.

To select a group, move the cursor to a group name that is displayed on the screen and click the name. The 

background color of the selected group will change to light blue.

Example: In the example below, [Group2] is selected.

The graph shows only the average value data and measured data which has been checked (	✓▢	) on the data list on 

the screen. Check the data you want to display on the graph.
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 ■ Graph Markers
Refer to the table below for the meanings of the markers plotted on each graph.

Table

Marker Description

〇 Data in the data list with a check mark

● Data in the data list that has a check mark and is selected*

▲ The average of the data in the data list with a check mark

* To select data, move the cursor to the data you would like to select from the data list displayed on the screen and 

click on it. The entire row containing the selected data will change to light blue. You can also select multiple data 

items by using the Ctrl button or Shift button.

Marker Display Example

 

 ■ Magnifying and Copying the Graph
To magnify the graph (maximum image display), double-click on the graph.

To copy a graph to the clipboard, right-click on the graph and select [Copy] from the menu. 
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You can save viewfinder images taken with the CM-17d built-in camera at the same time the measurement is made 

with the viewfinder images linked to the measurement data, or display them on the software screen.

 Notes   • To use the above functions, connect the CM-17d, press the electronic viewfinder key on the CM-17d before 

starting measurement, or press and hold the measuring button to switch the CM-17d LCD screen to the 

electronic viewfinder display (measurement position confirmation screen) before starting measurement. 

For information on how to configure settings for these instruments and related precautions, refer to the 

instruction manual for the instrument.

  • Make sure that the measurement target is displayed on the CM-17d LCD display unit before starting 

measurement.

 ■Settings Required to Save Image Data at the Time of 

Measurement as .mln2 file
Configure the following settings in the software before starting measurement.

Procedure

1.   Select [Instrument] menu → [Measurement condition settings].

2.  Check [Save measured images] in the viewfinder function.

3.  Click the [OK] button.

Viewfinder Image (CM-17d Only)
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 ■ Displaying Images at the Time of Measurement on the Main Screen

Procedure

1.  Click the Settings button on the right end of the graph/measurement image area,  

or select [View] menu → [Graph/Measurement image area settings].

2.  The screen below is displayed. Select [Display] for the viewfinder image taken during measurement.

3.  Click the [OK] button.

The viewfinder image of the data selected (background color: light blue)  in the data list will be displayed in the 

bottom left of the screen.
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 ■ Copying Image Data at the Time of Measurement
To copy the viewfinder image taken during measurement that is displayed on the screen to the clipboard, right-

click on the displayed image and select [Copy] from the menu.

 ■ Saving Image Data at the Time of Measurement in ZIP (png.) Format
You can save the finder image data you have obtained using the settings and procedures described on P.42 to 

your computer. <ZIP (.png)>

 □ Outputting All Group Images at the Time of Measurement as a Batch

Procedure

1.  Select [File] menu → [Export as measured Images file]. 

Alternatively, click the [Export as measured Images file] button on the toolbar.

2.  Specify the save folder and file name, then click the [Save] button.

 □ Saving Images at the Time of Measurement for a Single Group

Procedure

1.  Select the target group and right-click.

2.  Select [Group measurement image export] from the menu that appears.

3.  Specify the save folder and file name, then click the [Save] button. 
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 ■ Outlier Notification Function
This function uses the first measured data item in a group as reference data and issues a warning when data 

exceeds the threshold value you have set for comparison with the reference data (such data is called an “outlier”).

To use this function, configure settings using the procedure below as a reference.

Procedure

1.  Select [Instrument] menu → [Measurement condition settings].

2.  Check the methods for providing warnings on the displayed screen.

There are two warning methods, as described below.
(1) Check [Notify of outliers during measurement.] to display rows of outliers in red in the data list.

(2)  In addition to (1), if you want a warning message to be displayed immediately after performing the 

measurement, check [If the measured data is an outlier, a message screen will be displayed.].

3.  Set the parameter and threshold value.

Parameter Threshold value* Description of the threshold for each parameter

ΔE*ab 0 to 10 ΔE*ab value of measured data relative to reference data.

Hue-Value 0 to 10 The distance between plots for Hue and Value in 

the measured data relative to the reference data.

Hb-Melanin Index 0 to 10 The distance between plots for Hb and Melanin in 

the measured data relative to the reference data.

* Threshold that can be entered.

Other Functions
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4.  Click the [OK] button.

<Example of screen displayed when warning methods (1) and (2) are selected>

 Memo  When outlier notification are enabled, the parameters and thresholds are displayed in the status bar. 

 ■ Valid Values Extract Function
This function selects the combination of data (valid values) with the least variation in measured data from the data 

you have selected.

Procedure

1.  Select [Data] menu → [Measurement data settings].

2.  Click the [Other Settings] tab.
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3.  Set the Parameter and the Valid Data Count on the screen below.

Parameter Valid data count* Values used to calculate the minimum value for each parameter

ΔE*ab 2 to 11 The ΔE*ab value among the measured data.

Hue-Value 2 to 11 The distance between Hue and Value plots for the measured data.

Hb-Melanin Index 2 to 11 The distance between Hb and Melanin plots for the measured data.

* Number for which extraction settings can be configured.

4.  Click the [OK] button. 

5.  Select the source data from which to extract valid values.

 Memo  To select multiple source data items for extraction in the data list area of the main screen, hold down the Shift or Ctrl key and click the rows of 

the target data items. The background color of the selected data rows will change to light blue.

6.  Right-click on the data you selected in the data list (the row with a light blue background) to display the menu, then 

select [Valid value extraction].

<Before executing>
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<After executing>

The data among the data you selected that are marked with a check mark will be extracted as valid values.

 Memo   This software does not include a function that saves only the data of the extracted valid values. If the data was saved in CSV format, all 

data in the data list is saved, however the checkmark status of each data at the time of CSV save is also output. (Refer to P.50)

 ■ Auto Group Changing Function
The measured data is stored in the selected group. By setting [Automatic group switching], you can sequentially store measurement 

data into multiple groups, allocating a set number of measurement data items to each group.

The following explanation assumes that measurement is started from a state in which no measurement data has been stored in the 

group that was selected first.

Example:  When Auto Group Changing is set to “3 times” and a total of 6 measurements have been taken:

•  The data measured from the first to the third measurements is stored in the group that was selected first.

•  A new group will be generated automatically when the fourth measurement is taken. The data storage destination will 

automatically switch to the newly generated group.

• The data measured from the fourth to the sixth measurements is stored in the newly generated group.

Procedure

1.  Select [Data] menu → [Measurement data settings].

2.  Select the [Other Settings] tab.

3.  In [Automatic group switching], click the radio button located on the right and set the number of times*.

* Data storage destination, automatic switching measurement number of times.
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 ■ Creating a New File
 Select [New] from the [File] menu.

The file is created in the original format (extension: mln2).

 ■ Saving a File
 Select [Save As] or [Save] from the [File] menu.

The file is saved in the original format (extension: mln2).

 ■ Opening a File
 Select [Open] from the [File] menu.

You can open files (extension: mln2) that you created with this software (CM-SA2).

You can also open files (extension: mln) that you created with the old software (CM-SA).

• You can open only files which are in these two formats (extension: mln or mln2).

 Memo  • After opening the file, you can make additions or edits, then overwrite and save or save it as a new file under a file name.

 • When you use this software (CM-SA2) to open a file (extension: mln) that was created with the old software (CM-SA), 

values for data items* that are not available in the old software will also be displayed. 

* ITA°, ITA classification, C*, h, etc.

Creating a New File and Saving/Opening a File
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 ■ Outputting a CSV Format File
You can save the measured data, conditions used during measurement, and other information to your computer in 

CSV format.

The items saved in CSV format are given in the table below.

Table 

Column Item

A Group name

B Checkmark status

 0 =  Data without a checkmark in the data list  

on the screen

 1 =  Data with a checkmark in the data list  

on the screen

C Data number, etc.

D Data name

E Comment

F Melanin Index

G Hb Index

H Hb SO2 Index (%)

I Hue

J Value

K Chroma

L L*

M a*

N b*

O C*

P h

Q ITA°

R ITA° classification

S Observer/Illuminant

T Measurement area

U Instrument name

V-AZ Spectral reflectance (400 nm to 700 nm) 

Displayed every 10 nm*

* The measurement wavelength range of the CM-2600d is 360 nm to 740 nm, but the wavelength range of the measured spectral 

reflectance output in CSV format is 400 nm to 700 nm.

Utility Function
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 □ Outputting All Group Data as a CSV File

Procedure

1.   Select [File] menu → [Export as CSV file].

 Alternatively, click the [Export as CSV file] button on the toolbar.

2.  Name the file and save it.

•  The average value and standard deviation data displayed in rows 1 and 2 in the data list on the screen are 

not output.

 □ When Selecting a Group and Outputting the Data as a CSV File

Procedure

1.  Select the target group and right-click.

2.  Select [Group CSV file export] from the menu that appears.

3.  Name the file and save it.

•   The average value data of data with a checkmark is output to the second row of the CSV file.

•  The standard deviation data of data with a checkmark is output to the third row of the CSV file.  

 * Values of some items will be hidden (---).
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 ■ Printing or Outputting a PDF
You can print or save the data list and graph of the group displayed on the screen in PDF format.

  The data list and graph are output as two separate files.

When Printing

Procedure

1.  Click the name of the group on the screen to print, and change the background color of the group 

name to light blue.

2.  The data items and graphs to be printed are displayed on the screen. (Refer to P.29, P.39.)

• If the data items and graphs to be printed are already displayed on the screen, proceed to Step 3.

• All data items and graphs displayed using the scroll bar will be printed even if there are so many items and 

graphs to be printed that they cannot all be displayed on the screen.

3.  Click the [File] menu → [Print].

4.  The Print dialog box for the data list is displayed. Configure the settings and click the [OK] button.

5.  Next, configure the settings in the Print dialog box for the graph displayed, and click the [Print] 

button.

• If you are using Windows 11, the [Printing from Win32 application. - Print] screen.

When Outputting a PDF

Procedure

1. Click the name of the group on the screen to save as a PDF, and change the background color of the 

group name to light blue.

2.  The data items and graphs to be saved in PDF format are displayed on the screen. (Refer to P.29, 

P.39.)

• If the data items and graphs to be saved are already displayed on the screen, proceed to Step 3.

• All data items and graphs displayed using the scroll bar will be saved even if there are so many items and graphs 

to be saved that they cannot all be displayed on the screen.

3.  Click the [File] menu → [Print].

4.  The Print dialog box for the data list is displayed.

• For the printer, select “Adobe PDF” from the drop-down list.

Finally, configure the settings and click the [OK] button.

5. Set the save destination for the PDF file containing the data list, name the file, and click the [Save] 

button.
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6.  Next, configure the settings in the Print dialog box for the graph displayed, and click the [Print] but-

ton.

• If you are using Windows 11, the [Printing from Win32 application. - Print] screen.

• Set the print orientation to [Horizontal].

7.  Set the save destination for the PDF file containing the graphs, name the file, and click the [Save] 

button.

 Memo  • Data List: The data of the items (columns) set to be displayed on the software screen is printed or output as a PDF file.

 • Graph: The graph set to be displayed on the software screen is printed or output as a PDF file.

 • Finder Image Data: The viewfinder image taken during measurement with the CM-17d built-in camera is not output.

	■ When Changing Display Languages
  Select one language from Japanese, English, Simplified Chinese, Traditional Chinese, and Korean.

  Once you have selected a language, the change will take effect after restarting the software.

Procedure

1.  Select the [Application Setting] menu → [Language Setting].

2.  Select the desired language from the Language Selection screen, then click the [OK] button.

3.  Exit the software and restart it.
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